This document contains course outlines in computer-aided manufacturing developed for a business-industry technology resource center for firms in eastern Pennsylvania by Northampton Community College. The four units of the course cover the following: (1) introduction to computer-assisted design (CAD)/computer-assisted manufacturing (CAM); (2) CAM requirement analysis; (3) CAM software and evaluation; and (4) SMARTCAM. Exercises and transparency masters are included. Appendixes consist of part drawings, "hot key" definitions, and an outline of a programmable logic controls workshop. (KC)
COMPUTER AIDED MANUFACTURING

Developed by
Gerard Insolia

Center for Business & Industry
©Northampton Community College
3835 Green Pond Road
Bethlehem, PA 18017
1991
Special acknowledgement to the following organizations for documentation used in this training program:

Point Control Co.

Northeast Manufacturing Technology Center (NEMTC)
Rensselaer Polytechnical Institute
Rensselaer, New York
OUTLINE: COMPUTER AIDED MANUFACTURING

I. INTRODUCTION
   1. Rationale for CAD/CAM
   2. CAD/CAM Hardware
   3. CAD/CAM Software
   4. CAD-to-CAM Interface
   5. CAM-to-CNC Interface

   Objective: Give the student a perspective of CAM that includes why CAM is used, how it is implemented, and how it affects other areas of the company.

II. CAM REQUIREMENTS ANALYSIS
   1. Part Analysis
   2. CNC Machine Tools
   3. CAM Requirement
   4. CAD System
   5. Workforce

III. CAM SOFTWARE EVALUATION
   1. General Operation
   2. System Types
   3. Editing
   4. CAD Interfaces
   5. Post Processors
   6. User Support
   7. Cost Estimates
   8. Evaluation

IV. SMARTCAM
   1. Capabilities
   2. Available Functions
   3. General Method of Use
   4. User Interface
   5. Preparing to Write a Program
   6. Process Modeling
   7. Generating CNC Code
   8. Editing Code
   9. Communications
I. INTRODUCTION

1. Rationale for CAD/CAM
2. CAD/CAM Hardware
3. CAD/CAM Software
4. CAD to CAM Interface
5. CAM to CNC Interface

Definitions:

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Full Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAD</td>
<td>Computer Aided Design</td>
</tr>
<tr>
<td>CAM</td>
<td>Computer Assisted Machining</td>
</tr>
<tr>
<td>CNC</td>
<td>Computer Numerical Control</td>
</tr>
</tbody>
</table>
I. INTRODUCTION

1. Rationale for CAD/CAM

   Increased productivity
   Better quality products
   Better communications

   Integrated design & manufacturing
   Modeling - product & process
   Analysis - multiple conditions
   Review - check accuracy
   Documentation!!

   Reduced prototype costs
   Faster response to customers
I. INTRODUCTION

2. CAD/CAM Hardware

a. Operator Input Devices

Mouse
Keyboard
Digitizing Tablet
Trackball, Joystick

b. Computer

Central Processing Unit (CPU)
Memory (RAM)
Primary Storage (Hard Disk)
Secondary Storage (Floppy Disk)
Floating Point Processor (optional)

c. Output Devices

Monitor
Printer
Plotter
Disk Drives, Tape Drives
I. INTRODUCTION

3. CAD/CAM Software

   a. Operating System

      DOS
      UNIX, XENIX, AIX
      OS/2
      Network Operation System

   b. Application Program

      CAM System
      CAD System
      Postprocessor

   c. Utilities

      Translators (CAD to CAM)
      Communications (CAM to CNC)
I. INTRODUCTION

4. CAD to CAM Interface

IGES
DXF
CADL
VDA-FS
PDES

Translators allow geometry files to be exchanged with various CAD systems.

Shared Database Elements:
- mathematical models
- graphic images
- bills of materials
- parts lists
- size, form
- locational dimensions
- tolerance specifications
- material specifications
I. INTRODUCTION

5. CAM to CNC Interface

No standard protocol
Many proprietary designs
Historically high integration costs

Typically RS-232-C serial link
physical connection and voltage
level specification only

Protocol varies
data format, transmission
mode, baud rate, parity,
handshaking
II. CAM REQUIREMENT ANALYSIS

1. Part Analysis
2. CNC Machine Tools
3. CAM Requirements
4. CAD System
5. Workforce
II. CAM REQUIREMENT ANALYSIS

1. Part Analysis

Part Description
- Size and type of material
- Complexity of designs
  - tool changes
  - multiple fixtures
- Precision

Quantity per Part Cycle
- Number of parts/cycle
- Cycle time
- Machine usage
- Machine down-time

Projection for Future
- Expand business
- Increase quantity
- Increase precision
- Increase 3D parts
- Increase machine tool types
  - (mill, lathe, EDM, grinder, laser, punch, CMM, ...
II. CAM REQUIREMENT ANALYSIS

2. CNC Machine Tools

Machine tool types & description
  variety of machines
  simultaneous axis operations
  unique requirements

Controllers
  variety of controllers
  availability of postprocessors
  unique requirements

Program transfer
  tape/disk
  direct connection (hard wired)
  local area network (LAN)

Future
  increased axis operations
  quantity of machines
  variety of machines
II. CAM REQUIREMENT ANALYSIS

3. CAM Requirements

Review part complexity
- linear/circular interpolation
- drilling patterns/arrays
- pockets, pocket contours
- pockets with islands/holes
- part arrays
- ruled surfaces
- complex surfaces, multi-axis
- global blend radii

Macro capability
repeated sequences to save

Parametric programming
family of parts, user variables

Communication/Translation files
IGES, DXF, CADL, others

Operating systems
DOS, UNIX, MACINTOSH,...
Lofted surface.

Form_Patch surface.

Reproduced with permission of Point Control Co.
II. CAM REQUIREMENT ANALYSIS

4. CAD System

   In-House system(s)
       design and drafting of parts
       detail drawings of parts
       CAD to be transferred to CAM

   Communication files
       IGES, DXF, CADL, others

   Operating systems
       DOS, UNIX, MACINTOSH,...

   Hardware
       microprocessor
       display resolution and VRAM
       input devices (mouse, tablet,...)
       output devices (printer/plotter)

   Future
II. CAM REQUIREMENT ANALYSIS

5. Workforce

Engineering/Drafting environment
- design engineers
- product engineers
- drafting

CAD knowledge requirements
- CAD drafting/design functions
- CAD drafting/update
- CAD drafting/transfer

CAM knowledge requirements
- CNC programmers
- CAM programmers

Future workforce
- train designers in machining
- train CAM programmers to CAD
- evaluate local workforce for availability of needed skills
III. CAM SOFTWARE EVALUATION

1. General Operation
2. System Types
3. Editing
4. CAD Interface
5. Post Processors
6. User Support
7. Cost Estimate
8. Sample Evaluation
III. CAM SOFTWARE EVALUATION

1. General Operations

Design to Manufacture
- CAD to CAM vs. CAM only
- in-house CAD vs. vendor CAD

Issues:
- CAD layers
- who designs?
- who CAMs?

User Interface
- words meaningful to CNC ops
- feedback of current state
- prompts
- on-line HELP
- "hot keys", function keys
- mixed input modes (keyboard and digitizer or mouse)

Performance
- result time
- through-put time
% CAD TO CAM

VENDOR SOURCE       IN-HOUSE CAD

PRINTS
DISKETTE
ELECTRONIC

CAM PROGRAMMER

% CAM DIRECT

VENDOR SOURCE

PRINTS
DISKETTE
ELECTRONIC

CAM PROGRAMMER

Reproduced with permission of NEMTC
Displacement: (Ortho on) Second point: About to regen -- proceed? (Y)
Regenerating drawing.
Command:

CAM MENU/CAD based Screen from AutoCAM CAD/CAM software.

Reproduced with permission of NEMIC
MENU screen from SmartCAM CAD/CAM software.

Reproduced with permission of NEMTC
PERFORMANCE
- INPUT -

SYSTEM A
INPUT
PICK TOOL
PICK MILL
PICK CARBIDE
TYPE 4 FLUTE
TYPE .500
TYPE 25 IPM
TYPE 10 IPM
PICK COLOR

RESULTS
PROMPT FOR MACHINE
PROMPT FOR TYPE
PROMPT FOR FLUTES
PROMPT FOR DIAMETER
PROMPT FOR XY FEED
PROMPT FOR Z FEED
PROMPT FOR COLOR

SYSTEM B
INPUT
PICK TOOLCRIB
PICK MILL
PICK MATERIAL

RESULTS
PROMPT FOR MACHINE
PROMPT FOR MATERIAL

Reproduced with permission of NEMIC
PERFORMANCE

- PROCESS -

SYSTEM A

CREATE MACHINE SEQUENCE → CONVERT TO POST → GENERATE MACHINE CODE

SYSTEM B

CREATE MACHINE SEQUENCE → GENERATE MACHINE CODE

Reproduced with permission of NEMTC


<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Endmill 4 Flute Carbide</td>
</tr>
<tr>
<td>Automatic/Manual change</td>
<td>A</td>
</tr>
<tr>
<td>Tool number</td>
<td>1</td>
</tr>
<tr>
<td>Preload next tool &amp; OFF</td>
<td>OFF</td>
</tr>
<tr>
<td>Gage length</td>
<td>2.342</td>
</tr>
<tr>
<td>Length comp. 0 or HOME</td>
<td>1</td>
</tr>
<tr>
<td>Spindle speed</td>
<td>1800</td>
</tr>
<tr>
<td>Tool diameter</td>
<td>0.5</td>
</tr>
<tr>
<td>XY feedrate</td>
<td>25</td>
</tr>
<tr>
<td>Z feedrate</td>
<td>7</td>
</tr>
</tbody>
</table>

**Tool parameter screen from AutoCAM software.**

Reproduced with permission of NEMTC
Cutter compensation in control = off
Roll cutter around sharp corners
Cutter compensation in computer = left, center
Tool library: TOOLS.TL  Material: ALUM-S
Tool number = 1  Diameter offset = 0  Length offset = 1
Cutter diameter = 0.1250
Amount of stock to leave = 0.0000
Feedrate = 183.3500  Plunge rate = 91.6750  Spindle speed = 18335
Coolant = off
Rapid depth = 0.0000  Contour depth = 0.0000
Starting sequence number = 100  Increment = 2  Program n. = 0
No rotary axis
Linear array: $N_x, N_y = 1, 1$  $D_x, D_y = 0.0000  0.0000$
Depth cuts: Rough: 1 cuts at 0.0000  Finish: 0 cuts at 0.0000
Home position = X0.0000 Y0.0000 Z0.0000
Kill in the XY plane
Display: Tool (static, endpoints, run, delay = 0.80) Toolpath
->Select this line when through setting parameters

Tool Parameter Screen from MasterCAM 3D software.

Reproduced with permission of NEMTC
III. CAM SOFTWARE EVALUATION

1. General Operations

CNC Parameter Specification
- fixed order of entry
- flexible order of entry
  - full screen edit
  - dialogue boxes

Logical Sequence
- operation flow and prompts
- remember user selections
- customizable interface

Escape Procedures
- controlled return or escape
- accept/reject sequence
  - parameter screen
  - dialog box

File Structure
- remember user selections
- create correct file .extensions

System Through-Put
- function of user task request and hardware
- upgrade hardware, customize
ESCAPE PROCEDURE

STEP 1  DIGITIZE BOUNDARY
2  SPECIFY ROUGH POCKET
3  DIGITIZE ISLAND
4  SPECIFY POCKET OFFSET LEFT
5  ESCAPE
6  SPECIFY POCKET OFFSET RIGHT
7  SAVE ROUTINE Y/N

Reproduced with permission of NEMTC
FILE STRUCTURE

SYSTEM A

STEP 1 START SOFTWARE
2 ENTER PROGRAM FILENAME
3 ROUTINE "A"
4 SAVE FILE
5 ENTER PROGRAM FILENAME
6 SHOW GRAPHIC TOOLPATH
7 ENTER PROGRAM FILENAME
8 POST
9 ENTER PROGRAM FILENAME
10 SAVE PROGRAM
11 ENTER PROGRAM FILENAME
12 ETC.

SYSTEM B

STEP 1 START SOFTWARE
2 ENTER PROGRAM FILENAME
3 CALL ANY ROUTINE
4 ETC
SYSTEM THRU-PUT

SOFTWARE

HARDWARE

INPUT

PROCESS

CPU

DISK

GRAPHICS

PERFORMANCE

SPEED

THRU-PUT

Reproduced with permission of NEMTC
III. CAM SOFTWARE EVALUATION

2. System Types

CAD based
- familiar user interface
- purchase CAD and CAM
- external postprocessor
- slower thru-put (database conversions)
- easy manipulation of graphics
- easy macro functions

CAM based
- purchase only CAM
- fast thru-put (one database)
- possible CAD front-end
  - investigate drafting and detailing needs
- CAD interfaces are prime concern (import/export)
- internal postprocessor
- limited graphics manipulation

CAM/CAD based
- CAD front-end
- fast thru-put (one database)
- internal postprocessor
- good graphics manipulation
III. CAM SOFTWARE EVALUATION

3. Editing

Machine Code

- machine tool controller
  - quick changes
- text editor
  - part of CAM system
  - outside of CAM system

Part Geometry

- edit or change a toolpath
- resequence process
- graphical change confirmation

Toolpath Parameters

- tool diameter, direction, offset
III. CAM SOFTWARE EVALUATION

4. CAD Interface

Direct
- CAD to CAM on single layer
- Toolpaths defined in CAM
  - CAD designer not required
  - CAD software not required
  - CNC knowledge required

Indirect
- CAD operator alters layers to "fit" CAM system
- Must have access to CAD software or accept only jobs dedicated to CAM system
CAD INTERFACE

SYSTEM "A"

CAD

DXF
CADL
IGES
DWG

GEOMETRY
SORTED

GEOMETRY
UNSORTED

CAM

SYSTEM "B"

CAD

DXF
CADL
IGES
ETC.

TRANSLATOR

GEOMETRY
UNSORTED

CAM

Reproduced with permission of NDKC
III. CAM SOFTWARE EVALUATION

5. Post Processors

Generic

- usually supplied
- modified by user to fit needs

Custom

- proven for specific controller
- purchase at $300 - $1500 per post
- may get choice with system
III. CAM SOFTWARE EVALUATION

6. User Support

Phone
Software producer
Authorized dealer

Local Representative
Tech support
Update awareness
Update support

Training
Software producer
Authorized dealer

Bulletin Board System (BBS)
Updates
Utilities
Postprocessors
### III. CAM SOFTWARE EVALUATION

7. Cost Estimate

**a. 2 1/2 D, CAD based system**

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>CAD</td>
<td>$3,500</td>
<td></td>
</tr>
<tr>
<td>CAM</td>
<td>$3,000</td>
<td></td>
</tr>
<tr>
<td>GPOST</td>
<td></td>
<td>$1,500</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>$6,500</strong></td>
<td><strong>$8,000</strong></td>
</tr>
</tbody>
</table>

**b. 2 1/2 D, CAM based system**

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>CAM</td>
<td>$7,000</td>
<td></td>
</tr>
<tr>
<td>GPOST</td>
<td></td>
<td>$1,000</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>$7,000</strong></td>
<td><strong>$8,000</strong></td>
</tr>
</tbody>
</table>

**c. 2 1/2 D, CAD/CAM system**

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>$6,000</td>
<td></td>
</tr>
<tr>
<td>GPOST</td>
<td></td>
<td>$600</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>$6,000</strong></td>
<td><strong>$6,600</strong></td>
</tr>
</tbody>
</table>
III. CAM SOFTWARE EVALUATION

8. Evaluation
   a. Services and support
   b. Quality
   c. Delivery and installation
   d. Initial costs
   e. Ongoing costs
# EVALUATION CHART

<table>
<thead>
<tr>
<th></th>
<th>SYS A</th>
<th>SYS B</th>
<th>SYS C</th>
</tr>
</thead>
<tbody>
<tr>
<td>DESIGN TO MANUFACTURE</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>INTERFACE</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PERFORMANCE</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CNC PARAMETERS</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LOGICAL SEQUENCE</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ESCAPE PROCEDURE</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FILE STRUCTURE</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SYSTEM THRU-PUT</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CAD BASED</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CAM BASED</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CAM/CAD BASED</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EDIT CODE</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EDIT GEOMETRY</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EDIT PARAMETERS</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DIRECT CAD INTERFACE</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>INDIRECT CAD INTERFACE</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GENERIC POST</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CUSTOM POST</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>USER SUPPORT</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>COST W/O CAD</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CAD ADD'L COST</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>POINT TOTALS</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>COST</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Reproduced with permission of NEMIC
The numeric evaluation shown below is based on a scale from 1-5 with the number 5 being the highest rating. Each category expresses an inclusion/consideration based on Ease of Use, Functionality and Reliability.

<table>
<thead>
<tr>
<th>Evaluation category</th>
<th>System A</th>
<th>System B</th>
<th>System C</th>
</tr>
</thead>
<tbody>
<tr>
<td>General operation</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Design to Manufacture</td>
<td>4</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>- Interface</td>
<td>4</td>
<td>4</td>
<td>3</td>
</tr>
<tr>
<td>- Performance</td>
<td>5</td>
<td>4</td>
<td>3</td>
</tr>
<tr>
<td>- CNC Parameters</td>
<td>4</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>- Logical sequence</td>
<td>5</td>
<td>5</td>
<td>3</td>
</tr>
<tr>
<td>- Escape procedure</td>
<td>5</td>
<td>5</td>
<td>4</td>
</tr>
<tr>
<td>- File Structure</td>
<td>4</td>
<td>5</td>
<td>3</td>
</tr>
<tr>
<td>- System Thru-put</td>
<td>5</td>
<td>5</td>
<td>3</td>
</tr>
<tr>
<td>System Type</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- CAD based</td>
<td>-</td>
<td>-</td>
<td>3</td>
</tr>
<tr>
<td>- CAM based</td>
<td>4</td>
<td>4</td>
<td>-</td>
</tr>
<tr>
<td>Editing</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Machine Code</td>
<td>4</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>- Part Geometry</td>
<td>3</td>
<td>5</td>
<td>3</td>
</tr>
<tr>
<td>- Toolpath Parms</td>
<td>5</td>
<td>5</td>
<td>2</td>
</tr>
<tr>
<td>CAD Interface</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Direct</td>
<td>5</td>
<td>-</td>
<td>4</td>
</tr>
<tr>
<td>- In-Direct</td>
<td>-</td>
<td>4</td>
<td>-</td>
</tr>
<tr>
<td>Font Processor</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Generic</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>- Custom</td>
<td>4</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>User Support</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Phone</td>
<td>3</td>
<td>2</td>
<td>4</td>
</tr>
<tr>
<td>- Local Rep.</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>- HBS</td>
<td>-</td>
<td>-</td>
<td>4</td>
</tr>
<tr>
<td>Cost est.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Single post sys.</td>
<td>4</td>
<td>3</td>
<td>5</td>
</tr>
<tr>
<td>- Cad required</td>
<td>1</td>
<td>1</td>
<td>-</td>
</tr>
</tbody>
</table>

Totals (example)          72        69        62
Cost                      $10,000    $12,000   $9,500

Reproduced with permission of NEMTC
IV. SmartCAM

1. Capabilities

2. Available Functions

3. General Method of Use

4. User Interface

5. Preparing to Write a Program

6. Process Modeling

7. Generating CNC Code

8. Editing Code

9. Communications
IV. SmartCAM

1. Capabilities

Use existing CAD files or create new model

Built in speeds & feeds calculations

Solves creation and editing of geometry

Creates roughing passes for geometry profiles

Internal postprocessor, "code generator"
IV. SmartCAM

2. Available Functions

Job Plan  machine, tool, model layer info

Applications  mill, lathe, punch, EDM

Edit Plus  ASCII text editor

Communicate  RS-232 format

Design  Access CAD system from SmartCAM

CAM Connection  Convert CAM files to SmartCAM

Machine Define  Customize postprocessors
IV. SmartCAM

3. General Method of Use

a. Create/modify Job Plan file

b. Select Application

c. Construct geometry

d. Insert machining operations

e. Show path to review operations

f. Generate code

g. Download code to machine

h. Verify
IV. SmartCAM

4. User Interface

Graphical User Interface (GUI)

Mouse or Keyboard input

Workplace Environment
- top menu bar
- workbench
- toolbox
- list view
- control panel/dialogue box
- graphic window

Hot Keys

Screen Layout

Exercise 1: Existing Model
Hot Keys

SmartCAM Hot Keys are function keys that carry out or set a mode of operation when you press them. SmartCAM provides the following Hot Keys:

<table>
<thead>
<tr>
<th>Hot Key</th>
<th>What it Does</th>
</tr>
</thead>
<tbody>
<tr>
<td>[F1]</td>
<td>Enables you to input a value or coordinate. Displays the File Select Dialogue Box where appropriate.</td>
</tr>
<tr>
<td>[F2]</td>
<td>Turns Snap On or Off in the Read-out Line.</td>
</tr>
<tr>
<td>[F3]</td>
<td>Pulls down the Work Plane Menu.</td>
</tr>
<tr>
<td>[F4]</td>
<td>Redispalyes the last dialogue box.</td>
</tr>
<tr>
<td>[F5]</td>
<td>Pulls down the View Menu.</td>
</tr>
<tr>
<td>[F6]</td>
<td>Pulls down the Utility Menu.</td>
</tr>
<tr>
<td>[F7]</td>
<td>Displays data for a selected element (works the same as Element Data in the View Menu).</td>
</tr>
<tr>
<td>[F8]</td>
<td>Redraws the screen (works the same as Redraw in the View Menu).</td>
</tr>
<tr>
<td>[Esc][Esc]</td>
<td>Returns you to the File Menu from anywhere in SmartCAM. Press [Esc] twice in sequence.</td>
</tr>
<tr>
<td>[Alt]+[Letter]</td>
<td>Selects a pull-down menu from the menu bar. [Letter] should be the first letter of the pull-down menu you want to display. Press [Alt] and the [Letter] key at the same time.</td>
</tr>
<tr>
<td>[Alt]+[1,2, or 3]</td>
<td>Opens the toolbox preceded by the selected number on the workbench. Press [Alt] and the number key at the same time.</td>
</tr>
<tr>
<td>[Tab]</td>
<td>Advances to the next control panel field.</td>
</tr>
<tr>
<td>[Shift]+[Tab]</td>
<td>Moves back one control panel field.</td>
</tr>
<tr>
<td>[Alt]+[F8]</td>
<td>Redraws dialogue boxes and control panels.</td>
</tr>
</tbody>
</table>

Show_Path Keys

The following keys are operational in Show_Path:

- [Esc][Esc] Quits Show_Path.
- [Esc] Stops Show_Path so that you can change Show_Path speed.
- [S] Starts Show_Path.
- [Alt]+[H] Provides help for the current menu item, toolbox, control panel, dialogue box or modeling tool.
- [Home] Positions to the top of a list. Useful in Insert position.
- [End] Positions to the bottom of a list. Useful in Insert position.

Reproduced with permission of Point Control Co.
Graphic view

Normal text shows available options

Dim text shows options that are not available

Top Menu Bar

File Edit Create View Utility Work Plane Process Macro

Workbench

Toolbox

List view

The initial SmartCAM screen

Control Panel/Dialogue Box

Reproduced with permission of Point Control Co.
IV. SmartCAM

5. Preparing to Write a Program

Communicate information about the part to be machined, the tooling, and the setup to the CNC machine operator.

a. Plan the setup

b. Plan the tool path

c. Select tools

d. Select speeds and feeds
IV. SmartCAM

5. Preparing to Write a Program

Job Plan

Operation Information

1. Machine type
2. Machine
3. Drawing number
4. Part number
5. Operation number
6. Material blank
7. Special notes

Tool Data

1. Tool number or station no.
2. Tool type
3. Tool ID number (optional)
4. Offsets
5. Speed and Feed

Exercise 2: Existing Job Plan
IV. SmartCAM

6. Process Modeling

Milling (2 1/2 D)

- Geometry creation features
- Geometry edit features
- Verification features

Exercise 3: Free form geometry

Exercise 4: Profile geometry
IV. SmartCAM

7. Generating CNC Code

   Job Plan information
   Shape Database
   Machine File
   Template File

Exercise 5: Generate Code
Files used for Code Generation

Reproduced with permission of Point Control Co.
IV. SmartCAM

8. Editing Code

Edit Plus text editor

Exercise 6: Generate code
Modify job plan
Generate code again
View both files
Note differences
APPENDIX A:  PART DRAWINGS
APPENDIX B:  HOT KEYS
Hot Keys

SmartCAM Hot Keys are function keys that carry out or set a mode of operation when you press them. SmartCAM provides the following Hot Keys:

<table>
<thead>
<tr>
<th>Hot Key</th>
<th>What it Does</th>
</tr>
</thead>
<tbody>
<tr>
<td>[F1]</td>
<td>Enables you to input a value or coordinate. Displays the File Select Dialogue Box where appropriate.</td>
</tr>
<tr>
<td>[F2]</td>
<td>Turns Snap On or Off in the Read-out Line.</td>
</tr>
<tr>
<td>[F3]</td>
<td>Pulls down the Work Plane Menu.</td>
</tr>
<tr>
<td>[F4]</td>
<td>Redisplays the last dialogue box.</td>
</tr>
<tr>
<td>[F5]</td>
<td>Pulls down the View Menu.</td>
</tr>
<tr>
<td>[F6]</td>
<td>Pulls down the Utility Menu.</td>
</tr>
<tr>
<td>[F7]</td>
<td>Displays data for a selected element (works the same as Element_Data in the View Menu).</td>
</tr>
<tr>
<td>[F8]</td>
<td>Redraws the screen (works the same as Redraw in the View Menu).</td>
</tr>
<tr>
<td>[Esc][Esc]</td>
<td>Returns you to the File Menu from anywhere in SmartCAM. Press [Esc] twice in sequence.</td>
</tr>
<tr>
<td>[Alt]+[Letter]</td>
<td>Selects a pull-down menu from the menu bar. [Letter] should be the first letter of the pull-down menu you want to display. Press [Alt] and the [Letter] key at the same time.</td>
</tr>
<tr>
<td>[Alt]+[1, 2, or 3]</td>
<td>Opens the toolbox preceded by the selected number on the workbench. Press [Alt] and the number key at the same time.</td>
</tr>
<tr>
<td>[Tab]</td>
<td>Advances to the next control panel field.</td>
</tr>
<tr>
<td>[Shift]+[Tab]</td>
<td>Moves back one control panel field.</td>
</tr>
<tr>
<td>[Alt]+[F8]</td>
<td>Redraws dialogue boxes and control panels.</td>
</tr>
</tbody>
</table>

Show_Path Keys

The following keys are operational in Show_Path:

- [Esc][Esc] Quits Show_Path.
- [Esc] Stops Show_Path so that you can change Show_Path speed.
- [S] Starts Show_Path.
- [Alt]+[H] Provides help for the current menu item, toolbox, control panel, dialogue box or modeling tool.
- [Home] Positions to the top of a list. Useful in Insert position.
- [End] Positions to the bottom of a list. Useful in Insert position.

Reproduced with permission of Point Control Co.
PLC BASICS

Developed by
Gerard Insolia

Center for Business and Industry
Northampton Community College
3835 Green Pond Road
Bethlehem, PA 18017-7599
PLC BASICS SEMINAR OUTLINE

1. WELCOME AND PERSONAL INTRODUCTION

2. WHAT IS A PLC?

3. HISTORY OF THE PLC
   A. ORIGIN
   B. ORIGINAL INTENT OF THE PLC
   C. FLEXIBILITY AND SIMPLICITY
   D. ARE PLC'S COST EFFECTIVE?
   E. WHEN, WHERE, HOW AND WHY

4. BASIC COMPONENTS OF A PLC
   A. CENTRAL PROCESSING UNIT
   B. POWER SUPPLY
   C. I/O SYSTEM

5. LOGICAL FORMAT
   A. HAND LOADERS, CRT'S, DATA LOADERS AND PC'S/PC SOFTWARE
   B. LADDER LOGIC
   C. STATEMENT LOGIC
   D. STRUCTURED PROGRAMMING

6. REVIEW OF BASIC CONTROL CIRCUIT DIAGRAMS
   A. RELAY LOGIC EXAMPLES
   B. PLC WIRING DIAGRAM EXAMPLE
   C. PLC LADDER LOGIC EXAMPLES
   D. PLC STATEMENT LIST LOGIC EXAMPLES

7. EMERGENCY STOP AND SAFETY CIRCUIT CONTROL

8. ELECTRICAL NOISE PROBLEMS AND POTENTIAL SOLUTIONS

9. PLC APPLICATIONS AND EXAMPLES

10. QUESTION AND ANSWER

NOTES:

OVERHEAD SLIDES WILL BE UTILIZED

UTILIZE HANDOUTS SUCH AS THE WESTINGHOUSE PLC ARTICLES AND THE PLC EXPERT EXAM

INTERACTION WITH THE CLASS WILL BE ENCOURAGED
CAPABILITIES

What is a PLC?

Basics:
I/O Interfaces
Memory
Processor
Programming Language & Device
Power Supply
Housings
CAPABILITIES (cont)

How has the PLC evolved?

Relay Replacement

Arithmetic Operations

Interface with Analytical Instrumentation
  o obtain operation results
  o measure tolerances
  o perform calculations
  o take corrective action

Analog Control Functions

Indicator Lights

Self-Diagnostics
  o power indicators
  o transmission faults

Communications
  o Peripherals
  o Other PLCs
  o Distributed Control
CAPABILITIES (cont)

PLCs vs Other Types of Controls

**PLC vs. Computer**

- PLC designed to communicate with process directly
- Familiar programming techniques for a plant technician or electrician
- PLCs designed for industrial environment

**PLC vs Relays**

- Versatility and flexibility
- Simplified field wiring
- Space
SELECTION CONSIDERATIONS

System Attributes

1. I/O Requirements
   o Number of I/O points
   o Types of I/O
     - Discrete or analog
     - AC or DC
       AC: 24V, 115V, 230V
       DC: 5V, 12-30V
   o Special Features
     - High speed inputs
     - Servo drive module
     - Thermocouple module
     - Communications
   o Location of I/O
     - Distributed control
     - Remote I/O
SELECTION CONSIDERATIONS (cont)

2. Memory Requirements
   - Type
   - Capacity
   - Allocation
     - program area
     - executive programs
     - data table area

3. Programming Requirements
   - Instruction Set

4. Peripheral Requirements
   - Programmer
   - Printer
   - Modem
   - Computer
SELECTION CONSIDERATIONS

How Cost-Effective are PLCs?

Factors

- Purchase price
- Installation costs
- Throughput
- Machine system safety
- Versatility
- Downtime and repair costs
- System power consumption
- Expandability
- Longevity
APPLICATIONS

1. Bulk Material Handling

Fiberglass production at PPG Industries

System Description

- Raw ingredients weighed, mixed, transported
- Batch fed continuously into furnaces

Control Strategy

- Hierarchical control system
- 3 independent subsystems
- Semi- or fully- automatic operation
1. Bulk Material Handling (cont)

Fiberglass production at PPG Industries

Implementation

- Activated incrementally
- Distributed control with 20 PLCs
- Supervisory PLC coordinates operation and controls batch system
- Redundant processor and power supply
- Process computer performs monitoring, alarming, logging functions

Results

- System replaces two operators
APPLICATIONS

2. Controlling Heat Treating Ovens

General Electric Company

System Description

- Rail car loaded with six 30,000 pound ingots is run into the oven
- Oven brought up to Temp1 and maintained
- Temp dropped at controlled rate until Temp2
- Cycle repeated four times

Control Strategy

- Oven divided into three segments, six zones
- 1 sensor for each segment
- 2 secondary sensors for each segment
2. Controlling Heat Treating Ovens

General Electric Company

Implementation

- Combustors fueled from motor driven valves
- 2-speed circulating fans distribute heat
- One PLC controls oven temp, valves, fans
- PID control used to minimize temperature fluctuations

Results

- Large energy savings due to accurate control
APPLICATIONS

3. Packaging Food in Glass

FLOE Inc.

System Description

- Glass containers are fed, cleaned, filled, and capped
- Containers are queued if necessary
- Containers are labeled, assembled into cases, and palletized

Control Strategy

- Variety of inputs suited to particular tasks
- Control conveyor speed for better filling
- Active accumulator to control supply to labeler
3. Packaging Food in Glass

FLOE Inc.

Implementation

- Proximity, photocell, and microswitch inputs
- All motor control sequenced by the PLC
- Accumulator conveyor driven forward or reverse, based on labeler load
- PLC counts each jar, cap, and label. Records time and count of all line malfunctions.
- Report generated showing efficiency of each piece of equipment on the line

Results

- Total line efficiency monitoring aids maintenance management
- Equipment replacement simplified
APPLICATIONS

4. Energy management

Seaboard Energy Systems, Inc.

Reducing electrical consumption and peak demand

- Monitor electric meter to pinpoint rising consumption
- PLC shuts down predetermined equipment to avoid peak charges

Managing chillers

- Monitor chilled water in the loop, ambient temp, discharge and return temp, and chiller load
- Control difference between discharge and return water temps, units on/off line
4. Energy management (cont)

Seaboard Energy Systems, Inc.

Controlling boilers

- Monitor steam flow and steam pressure
- Increase/decrease the fuel flow as steam pressure drops/increases

Controlling outside dampers

- Monitor outside air temp and return air temp
- Control amount of fresh air mixed with return air to be heated or cooled
- Use motorized damper controls to open/close the dampers as temperature changes during the day

Results

- 10 to 20 percent reduction in energy consumption and costs
APPLICATIONS

Industry Breakdown

Automotive
Utilities and Oil Refineries
Food and Beverage
Glass, Rubber, Plastics, Chemicals, Paper,
Agricultural and Engineering Products
CON7ROL POtue R. nt4A/SFOR "eit CFS

20 HP, 1.15 SF
380/460V/60 Hz
20 AMP FLI.

CONTROL
POWER
TRANSFORMER

CF3 X1
120 V AC

TS1 E-STOP START

MCR

MAIN
CONTROL
RELAY

CONTROL
POWER
ON/ENABLED
CONTROL POWER TRANSFORMER

20 HP, 1.15 SF
3Ø/460V/60 Hz
27 AMP FLI

MAIN CONTROL RELAY

CONTROL POWER ON/ENABLED

FORWARD RUN INDICATION

FORWARD

REVERSE

REVERSE RUN INDICATION
PLC System Components

Inputs

Processor (CPU)

Outputs

Field Devices

Field Devices

Loader
I/O Example

Control Panel

Open Start
Close Stop

Horn

Pump Motor

Tank

Level

Valve
20 HP, 1.15 SF
3Ø / 460V / 60 Hz
277 AMP FLI
<table>
<thead>
<tr>
<th>Competition Item</th>
<th>SYS A</th>
<th>SYS B</th>
<th>SYS C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design to Manufacture Interface</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Performance</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CNC Parameters</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Logical Sequence</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Escape Procedure</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>File Structure</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>System Thru-Put</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CAD Based</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CAM Based</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CAM/CAD Based</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit Code</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit Geometry</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit Parameters</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Direct CAD Interface</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Indirect CAD Interface</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Generic Post</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom Post</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>User Support</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cost W/O CAD</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CAD Addl. Cost</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Point Totals</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cost</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Reproduced with permission of NDMTC
AUTOMATION FOR SMALL MACHINE SHOPS

Two Types of Automation

Automation That Improves The Management Of The Shop
- Identify Bottlenecks
- Improve Cost Estimates
- Improve Tool Management
- Improve Project Management

Automation That Improves The Productivity of Machines
- Consistent High Quality
- Higher Production Rates
- Easy Storage, Retrieval, Modification
- Take Advantage of Similarities (Group Technology)
- Reduce Labor Cost

BENEFITS

OVERALL: Reduce Thru-Put time and Maintain Consistent High Quality
Definition of System Requirements

I Part analysis. ........................................ Page
   A. Part description.
   B. Quantity/Part cycle.
   C. Projection for future.

II CNC machine tools. ......................................
   A. Machine tool types.
   B. Machine tool description.
   C. Controllers.
   D. Program transfer.
   E. Projection for future.

III CAM requirements. ....................................
   A. Part complexity.
   B. Macro capability.
   C. Parametric programming.
   D. Communication files.
   E. Operating system(s).

IV CAD system(s). ........................................
   A. In-House requirements.
   B. Communication files.
   C. Operating system(s).
   D. hardware.
   E. Projection for future.

V Workforce. ..........................................
   A. Engineering/Drafting.
   B. CAD knowledgeable.
   C. CAM knowledgeable.
   D. Projection for future.

Reproduced with permission of NEMTC
II CNC Machine tools.

A. Machine tool types.

1. Milling.
   a. 2 axis.
   b. 3 axis.
   c. 4 axis.
   d. 5 axis.

2. Turning.
3. Electrical discharge.
   a. Solid.
   b. Wire.

   a. Surface.
   b. Cylindrical.

5. Laser.
6. Router.
   a. 3 axis.
   b. 5 axis.

7. Punch.
8. Coordinate measure.

Reproduced with permission of WEDTC
B. Machine tool description.
   1. 
   2. 
   3. 
   4. 
   5. 
   6. 

C. Controllers.
   1. 
   2. 
   3. 
   4. 
   5. 
   6. 

D. Program Transfer.
   1. Tape/disk transfer. 
   2. Direct connect. 
   3. Local network. 

E. Projection for future.
5. CATIA (IBM).  
6. GDF (IBM).  
7. CADAM.  
8. HPGL (Hewlett-Packard).  
9. CGM (Computer graphics Metafile).  
10. NFL (Anvil).  

E. Operating system(s).  
1. PC-Dos/MS-Dos.  
2. UNIX.  
3. Macintosh.  
4. Other.

Reproduced with permission of NENTC
IV CAD system(s).

A. In-house requirements.
   1. Design and drafting of parts.  
   2. CAD used for transfer to CAM.  
   3. CAD used for detailed drawings.  

B. Communications files.
   1. EMI (Ansi for MAPICS).  
   2. DXF (AutoCAD).  
   3. IGES. (universal).  
   4. CADL (CadKEY).  
   5. CATIA (IBM).  
   6. GDF (IBM).  
   7. CADAM.  
   8. HPGL (Hewlett-Packard).  
   9. CGM (Computer graphics Metafile).  
  10. NFL (Anvil).  

C. Operating system(s).
   1. PC-Dos/MS-Dos.  
   2. UNIX.  
   3. Macintosh.  
   4. Other.  

Reproduced with permission of NENTC
D. Hardware.

1. Microprocessor/Co-processor.
   a. XT 8088/8087 processor.
   b. AT 80286/80287 processor.
   c. AT 80386/80387 processor.
   d. Macintosh.
   e. Other.

2. Display device.
   a. 12" monochrome/color.
   c. 14" Monochrome/color.
   e. 16" or larger color.

2. Input devices.
   a. Digitizer.
   b. Mouse.

3. Plotter

4. Scanner.

E. Projection for future.
V Workforce.

A. Engineering/Drafting.
   1. Employees working as Design engineers.
   2. Employees working as Production engineers.
   3. Employees working as manual drafting.

B. CAD knowledgeable.
   1. Employees working as CAD drafting/design.
   2. Employees working as CAD drafting/update.
   3. Employees working as CAD drafting/transfer.

C. CAM knowledgeable.
   1. Employees working as CNC programmers.
   2. Employees working as CAM programmers.

E. Projection for future. (yes no months)
   1. Train manual programmers for CAM. Y__ N__ Ms__
   2. Train CAD programmers for CAM. Y__ N__ Ms__
   3. Hire additional CAM programmers. Y__ N__ Ms__
   4. Train manual draftperson for CAD. Y__ N__ Ms__
   5. Hire additional draftperson for CAD. Y__ N__ Ms__

6. Additional comments:

Reproduced with permission of NERSTC
Additional comments

I Part analysis.

II CNC machine tools.

III CAM requirements.

IV CAD requirements.

V Workforce.

Reproduced with permission of WENTC